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Introduction

SecureNetTerm

SecureNetTerm is an interactive communications program designed for communication with hosts supporting the telnet,
SSH and SSL/TSL network protocols. SecureNetTerm supports all the popular terminal emulations used today.

A common question is what emulation do | need? The answer to that depends upon the host that you connect to. Most
sites will document the required emulation in their access their system, while others will provide a menu selection at
connect time, which allows you to specify the emulation type. In either case you must provide the emulation type in the
site profile for that host. A good selection is ANSI if you are not sure.

The Site Profile Manager maintains the site profiles, which contain all the necessary information required to access a
host, such as userid, password, protocol, host name, port, etc. The host name consists of a fully qualified network name
or an IP address, which is used to identify the host. Each computer on a network, connected directly or through the
Internet, has a unique name and IP number. Think of the network name as you would your name. Then think of the IP
address as your telephone number. As with the telephone system, you cannot connect by name but by phone number.
However if SecureNetTerm knows either one, it can determine the other using a technique similar to looking it up in the
white pages. The only thing important is that one must be entered into the site profile. Using the network name is of
course the best way, since if the IP number changes, SecureNetTerm can still connect by looking up the new number
based upon the qualified network name. IP numbers are just as dynamic as phone numbers, but the network name
normally remains the same.

In addition, each site profile contains all the related security information, such as authentication type, public/private keys
and/or certificates to use to automate the login process. The Security Manager is used to define and change security
related information.

Hosts that are only accessed occasionally can be connected to using the “QuickConnect” dialog bar.

Whenever SecureNetTerm is connected to a host, the animation at the upper right of the screen will be active. This acts
as a visual reminder to the user that SecureNetTerm has an active, open connection to a host. The animation can be
turned off within the View menu item.

Mouse Panning

SecureNetTerm supports mouse panning for both horizontal and vertical scrolling. Mouse panning is enabled by
pressing the middle mouse wheel or by selecting the Mouse Panning menu item from the Options menu. The speed of
the pan is controlled by the distance of the cursor from where you started panning.
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Dynamic Views

SecureNetTerm has the ability to display one host per window, or multiple hosts per window. Displaying multiple hosts
within a single window is referred to as Dynamic Tab Views, and can be enabled with the View-Dynamic Tab Views
menu item. The View-Window Tab Bar menu item controls the display of the window tab bar which allows for
selection of the active window.

If the Dynamic Tab Views option is not selected, a single host will be displayed in the SecureNetTerm window.
Additional hosts can be connected using multiple windows. The Windows Tab Bar can be used to switch between the
multiple windows, as well as the Window menu. In addition, the Window menu contains the options "New Window",
"Tile Windows" and "Cascade Windows" to manange the multiple windows.

If the Dynamic Tab Views options is selected, multiple hosts will be displayed in a single SecureNetTerm window. The
Windows Tab Bar is used to switch between the multiple hosts. The ability still exists to have multiple SecureNetTerm
windows, each containing a singe host or multiple hosts.

Note that the Windows Tab Bar must be enabled prior to enabling the Dynamic Tab Views option.

Font Facts

The use of fonts within a terminal emulation program tends to generate a lot of confusion and requests for assistance.
This short discussion of fonts should help you understand the importance of fonts, how they affect a terminal emulation
program, and what impact they have upon what gets displayed on the screen.

First, emulation programs use fixed pitch fonts, just like the real terminals they emulate. This is in contrast to most
Windows based editors that use proportional fonts. A fixed pitch font simply means that all the characters that get
displayed have the same width and height, resulting in a display that always has the same width and height for a given
number of rows and columns. The number of fixed pitched fonts is few, when compared to the number of proportional
fonts. The most common are the ones supplied with this program (NetTerm Ansi and NetTerm OEM), and the
Microsoft fonts Courier New, Lucida Console and Terminal.

Fixed pitched fonts also implies that the ratio of width verses height be maintained at a fixed ratio. When the terminal
emulator program window is dragged by the user, the number of rows and columns are normally held constant. The font
size is increased/decreased, while maintaining the fixed ratio. When the dragging action has been completed, the
program computes the closest font size, then computes the width of a frame to enclose the resulting display. The role of
the frame is to maintain the proper font ratio for the specified window size.

The window size is also affected whenever the user, or host, changes the number of rows or columns. In this case, the
font is held constant and the number of rows/columns is changed.

SecureNetTerm supports two major font/window size models. That is, you can select to change the font size, or the
number of rows/columns when the window size is changed. The most common method is to keep the rows/columns
constant, and change the font size.

Fonts are used to translate a data character sent from the host to a visible item on the screen. Internally, the emulator
program is not concerned with what is being received, or what is being displayed. It simply receives the data, and
instructs the system to display the character associated with its value from the font that is currently selected. Most
emulator programs, including this one, only support Ansi and extended Ansi characters sets. This implies it supports the
range of characters with a numerical value of 0 to 127 for Ansi and 0 to 255 for extended Ansi. An important thing to
remember is just because the emulator program supports the character range of 0 to 255 does not imply that the host or
the host application programs supports that range.

Historically, hosts and the terminals connected to them, used the Ansi character set, which restricted the range of
characters from 0 to 127. This range was not sufficient to handle language unique characters, which resulted in special
character translation tables on the host and within terminals. The most common is the set of tables referred to as the
National Replacement Characters (NRC). SecureNetTerm supports the National Replacement Characters, as well as the
ability to define user specific keyboard and video lookup tables.



Text Selection

SecureNetTerm has three modes of text selection, consisting of word highlighting, current page text selection and multi-
page text selection. A word is defined as a series of data characters without embedded blanks.

A word can be selected by double clicking the word with the left mouse button. The most common use of this is to
select a word, then use the right mouse menu Copy/Paste option to copy the word to the clipboard, then paste it at the
current cursor location in one operation.

Current page text selection allows for the selection of data within the current page (that data that can be seen on the
screen) by pressing the left mouse button and then moving the mouse to highlight the desired text. Note that this mode
uses a modified block mode.

Multiple page text selection uses the block mode concept. The text selection is initiated by a shift-left mouse click at the
upper left corner of the text to be selected. A shift-left mouse click at the lower right corner completes the text selection.
The scroll bar is used to scroll the data between the initial and final shift-left mouse clicks. This mode can be used on
the current page as well as multiple pages of data.

Help File Text Size

The text size within the right pane of this Microsoft help file can be changed with the Microsoft Browser View-Text
Size menu item. If you change the text size with the Browser, you must close this help file, and display it again to
reflect the new text size.

System Requirements

A minimum of a 486-based machine with 16 megabytes of RAM. The speed of the machine, and the available RAM
will have a direct relation to file transfer rates.

Windows® 98/ME, 2000, XP®, or Vista®.
Winsock.dll or wsock32.d1l compliant with version 1.1 or above.
A minimum screen resolution of 800x600 pixels.

A video card with a 16 bit (medium) or 24 bit (high) color quality support. Video cards with less than 16 bit color
quality will result in poor icon resolution.

Control Information

SecureNetTerm maintains three user specific files, SecureCommon.xml, SecureCommon.ini and the known_hosts file.
These three files are placed in the users specific application data directory during the program installation by the
Installshield installation program, when the Installshield program is run by the end user. If the program is installed by
the System Administrator, refer to the System Administration Issues section.

The location of the application data directory differs with the various types of Microsoft systems; common locations are:

Windows 98 C:\WINDOWS\Profiles\<user>\Application Data\InterSoft Common
Windows XP C:\Documents and Settings\<user>\Application Data\InterSoft Common
Windows Vista C:\Users\<user>\AppData\Roaming\InterSoft Common

The term <user> is unique for each individual that has been assigned a userid on the workstation.

The SecureCommon.xml file contains all the information that is unique for each host and associated security
information. The SecureCommon.ini file contains global information that is common to all hosts. The known_hosts file
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contains a unique identifier for each host connected to with the SSH protocol. If you have a need to migrate to another
workstation, or to install SecureNetTerm on another system and desire to maintain this information, simply copy the
three files to the new system after you install SecureNetTerm.

As with any other mission critical data file, it is wise to create backup copies of these files on a regular basis.

Items that are of a temporary nature, or that can be easily reset, are maintained in the system registry under the key:

HKEY-CURRENT-USER/Software/InterSoft International, Inc./SecureNetTerm

This includes such items as the window size, window position, state of ToolBar icons, size of each unique display area
and other display characteristics.

The Installshield installation routine will determine the proper location of the SecureNetTerm control files and will
insert their locations in the following registry keys:

HKEY-CURRENT-USER-Software/InterSoft International, Inc./SecureNetTerm/UserIniFile
HKEY-CURRENT-USER-Software/InterSoft International, Inc./SecureNetTerm/UserSiteFile
HKEY-CURRENT-USER-Software/InterSoft International, Inc./SecureNetTerm/UserKnownHosts

Changing these keys can change the location of the SecureCommon.ini and SecureCommon.xml files.

Internationalized Domain Names (IDN)

SecureNetTerm supports IDNA (Internationalizing Domain Names in Applications ) for domains with unicode
characters. IDNA is a mechanism to represent non-ASCIl domains with only ASCII characters. This feature is
transparently implemented, domain names with unicode characters are automatically converted to the IDN format.

For Windows 95/98, install Microsoft's Windows Installer Redistributable which will update your system's RichEdit
Control to version 3.0. If you need support for multibyte languages, such as Chinese and Korean, you will need a
unicode truetype font such as "Arial Unicode MS" from Microsoft.

References
VeriSign IDN-client for |IE
IDN Convertor Test

RFC

String Preparation (stringprep)
IDNSs in Applications (IDNA)
Name Preparation (nameprep)
Encoding Scheme (punycode)

Library and SDK
VeriSign IDN Software Development Kit

Internationalized Keyboard Configuration

Users that have an XP system, that have a need to enter international characters can use the following tip:

1. Start -> Settings -> Control Panel
2. Regional and Language Options
3. Languages -> Details ...


http://www.microsoft.com/downloads/details.aspx?displaylang=en&FamilyID=CEBBACD8-C094-4255-B702-DE3BB768148F
http://www.idnnow.com/
http://josefsson.org/idn.php/
http://ietf.org/rfc/rfc3454.txt?number=3454
http://ietf.org/rfc/rfc3490.txt?number=3490
http://ietf.org/rfc/rfc3492.txt?number=3492
http://ietf.org/rfc/rfc3491.txt?number=3491
http://www.verisign.com/nds/naming/idn/sdk.html

4. Click Add.
5. Under Input language, choose your native language.
6. Under Keyboard layout/IME, choose United States-International.

Now to form accents, you prefix the letter with either * ' ** or ~ So, to get &, one types * and then e. To get E, one types "

and then E.

System Administration Issues

The Installshield installation routine normally determines the proper location of the SecureNetTerm control files (see
Control Information ) and will insert their locations in the following registry keys:

HKEY-CURRENT-USER-Software/InterSoft International, Inc./SecureNetTerm/UserIniFile
HKEY-CURRENT-USER-Software/InterSoft International, Inc./SecureNetTerm/UserSiteFile
HKEY-CURRENT-USER-Software/InterSoft International, Inc./SecureNetTerm/UserKnownHosts

In addition, the three control files (as distributed from InterSoft) will be copied from the program installation directory
to the locations pointed to by these registry entries

If it is desired to distribute custom versions of the three control files, they should be placed in the installations directory
(replacing those placed there by Installshield on the initial installation by the system administrator). Subsequent
installations performed by Installshield will then use the custom files. System administrators should consult Installshield
and Microsoft documentation for detailed instructions on unique installation requirements.

If the program cannot locate the user specific SecureCommon.ini, SecureCommon.xml and known_hosts files upon
initial startup, the users unique application directory will be determined with the Microsoft API ShGetSpecialFolderPath
using a nFolder value of CSIDL_APPDATA. The program will then copy the SecureCommon.ini, SecureCommon.xml
files and the known_hosts files located in the program installed directory to the users unique application directory. The
registry will then be updated to reflect the correct location of these files.

Copyright and Trademarks

SecureNetTerm™ Copyright © 1995-2004 InterSoft International, Inc. All Rights Reserved
SecureNetTerm™ is a registered trademark of InterSoft International, Inc. in the United States and/or other countries.

SSH® and SSH2™ are registered trademarks or trademarks of SSH Communications Security Oyj in the United States
and/or other countries.

Windows® and Windows NT® are registered trademarks of Microsoft Corporation in the United States and/or other
countries.
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How T0

Show a Logo

SecureNetTerm can display a logo whenever a connection is not active. The logo file must be in a BMP (bitmap),
JPEG, or GIF format. Control of the logo display, and the file containing the image, is defined in the Global Settings-
Logo dialog which can be accessed from the toolbar or the Options menu.

It the image is a GIF format, you have the option of designating one color in the image as transparent when that image is
created. This transparency feature is normally used to make it appear as if an irregularly shaped image is floating on the
background. That is, if the image selected for display is a GIF format, with a transparent color, the transparent color will
be changed to the current SecureNetTerm background color whenever it is displayed. The transparent GIF feature is
only supported by Microsoft on Windows XP based systems.

The transparency feature is also supported with a BMP (bitmap) file on all versions of Windows. The bitmap file should
have a single color reserved as a background or transparent color. In the Logo dialog, select the "Enable Image Mask
Color" option, and then choose the image background or transparent color. When the image is displayed, this color will
be changed to the current SecureNetTerm background color.

Create a new profile

SecureNetTerm is normally distributed with example configurations for many of the host sessions that it supports. Each
protocol, such as telnet, SSH-1, SSH-2 and TLS/SSL has many configurable options that must be correct for a
successful connection. The example host profiles provide a template which can be used to create a new host profile with
a minimum of effort.

To add a new host profile, press the “Site Profile Manager” icon on the ToolBar. This will open up the Site Profile
Manager. The Site Profile Manager maintains folders and profiles within those folders for use with both SecureNetTerm
and SecureFTP. Profiles that are used for both are referred to as dual use.

On the left side of the window is a tree containing folders associated with a protocol, and example host entries for that
protocol. The Interactive folder contains examples for the telnet protocol, direct connect and dialup hosts. The
MyFTPS folder contains examples for TLS/SSL hosts. The mySFTP folder contains examples for the SSH protocol,
including SSH-1 and SSH-2, for connecting to SSH server software from OpenSSH and SSH Data Communications.

To add a new site, select an current folder (or add a new folder) and press the "New Site" button. If you first highlight a
current site, then press the shift key at the same time you press the "New Site" button, the highlighted site will be
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duplicated. Then provide the new site with a descriptive name. The next step is to provide all the required connection
information for the new site.

The shift-New Site is one of the most powerful features of the Site Profile Manager. It allows you to create a new host
profile, exactly like the one you currently have, by just changing the host name after the new profile has been created.
In most cases this is all that is needed for those that always connect to hosts with the same Operating System, using the
same protocol, such as SSH.

Userid/Password Considerations

Every host protocol supported by SecureNetTerm requires a valid userid for connecting to a host. Most protocols
require a password. The fact that these two items are user dependent requires special consideration for both
SecureNetTerm and the user. Each protocol has different methods for providing these two items, which a vastly
different.

The telnet protocol, as well as the direct connect and dialup hosts ask for the userid and password interactively. The
format, method and timing of how each host type requests this information is not consistent, requiring each to be
supplied manually by the user, or by scripts created by the user.

For more advanced protocols, such as SSH, both the userid and password are passed to the host in a well defined
method. The remainder of this topic pertains to the SSH protocol.

If the userid and or password is the same for most, if not all, of the hosts you connect to, then they should be specified in
the Global Settings-Connection-Control panel. If you have a few hosts that have a different userid and or password, you
can place them in the host profile for those few hosts, or you can have SecureNetTerm request them at connect time.
Whenever the host requests either the userid or password, SecureNetTerm will first check the host profile, then the
global definition. If they are not contained in either location, each will be requested interactively.

Connect to a host using a profile

SecureNetTerm has the ability to remember the last profile you connected to, as well as a default host. When you start
SecureNetTerm, and you want to connect to the last active host, simply press the “Connect” icon on the ToolBar. To
select a new host profile, press the “Site Profile Manager” icon, and then select the desired host. You can then press the
“Connect” button in the Site Profile Manager, or you can exit the Site Profile Manager, then press the ToolBar
“Connect” icon.

If you select the "Default Host" checkbox for a host, it will always be displayed when you open the Site Profile
Manager.

Connect to a host without a profile

You can connect to any host without the need to create a host profile using the QuickConnect bar. This is useful for
those hosts that are rarely accessed.

The QuickConnect bar can be used to connect to all types of host servers. It also allows for userid/password
authentication for each server type. If a SSL/TLS server requires a client certificate, a popup dialog will be presented
when the server requests the client certificate. The popup dialog will display a list of your certificates, and allows you to
view/select the proper one to use.



To enter a new host, simply type over the current host name and the other fields. When you press the "QuickConnect"
button (the first button on the left side of the bar) to connect, the new host will be entered into the QuickConnect history
list. This list can be cleared at any time by pressing the "QuickConnect" button while holding down the Shift-Delete
keys. The current entry can be deleted by pressing the "QuickConnect" button while holding down the Ctrl-Delete keys.

Use X.509 Certificates

A X.509 digital certificate is a set of electronic credentials that uniquely identify an individual. There are two parts to a
digital certificate: a private key and a certificate.

Your private key is the piece of information that uniquely identifies you within the Public Key Infrastructure. The
private key is mathematically created on your personal workstation, under your supervision, and is known only to you.

The certificate is the public part of your digital certificate. It contains your name and other identifying information. It
also contains the public key, which is mathematically related to the private key. Using your certificate, other people can
verify that you hold your private key, and therefore, must really be who you say you are.

Certificates can be generated and stored within browser software stores (databases), or within specialized Smart
Cards/USB tokens. Smart Cards/USB tokens are hardware devices that protect the private key from access by anyone
accept the owner. This is the main benefit of these devices. They serve as an impenetrable safe for the private key,
ensuring that only the intended user has access to it. The private key can be generated on-board and never leaves the
device for signing and encryption operations.

Certificates can be used for authentication with servers supporting SSH and SSL/TLS.

Manage SSH Host Keys

The SSH authentication allows public/private RSA keys, as well as X.509 certificates to be used for client
authentication. Although the documentation of many host SSH servers only refer to public/private RSA keys, X.509
certificates can still be used, since these certificates are nothing more than public/private keys with enhanced security
related information contained within a “certificate”. The public key is a component of this certificate. SecureNetTerm
fully supports the use of certificates for public/private key authentication.

The concept of public/private key authentication is a public/private key pair is created on the workstation. The private
key is retained on your local workstation, the public key is transferred to the host and placed in a unique location
specified by the host SSH server. When you attempt to login to a host using public/private key authentication, the host
server will send a challenge to SecureNetTerm. SecureNetTerm will sign this challenge with your respective private key
and return the signed challenge to the host server. The server will then verify the signed challenge using your public
key. If the host server determines that you are the holder of the correct private key, it will allow you to login. Refer to
the Key Management section on how to create and install these key pairs.

Manage SSL/TLS .tlslogin file

Most UNIX based SSL/TLS servers allow logging into the system with only a userid and a certificate. This is
commonly referred to as client certificate authentication. Although the complete details/requirements on how to enable
this feature can only be provided by the system administrator of the host, almost all of these systems require a copy of
the client certificate be located on the host. The .tlslogin file, located in the users home directory, is commonly used to
contain these user certificates. Most servers allow multiple certificates to be placed within the file.

Guide to Using SecureNetTerm 1BHow To e 15



Once you have obtained a user certificate for your workstation, and have selected that certificate to be used for SSL/TLS
access to a host, you can export that certificate to a file, then copy that file to the host and place it in the .tlslogin file.
Refer to the SSL/TLS security section on how to define, create and install the certificate.



Program Overview

Menus

File Menu

The file menu supports connecting/disconnecting a host, access to the Site Profile Manager, printer management and
program exit. The "Process SmartPrint" item is normally grayed out indicating that no printer output is pending within
SmartPrint. This item will be enabled whenever the SmartPrint option is enabled, and printer output has been received
form the host. If enabled, this option should be selected prior to closing SecureNetTerm to send the contents of the
SmartPrint buffers to a printer.

Edit Menu

The edit menu provides copy/paste clipboard support and special terminal requirements.

The copy/paste menu items support both the active (current) screen as well as the scroll back buffer. The scroll back
buffer contains data that was once displayed on the active screen, and was then "scrolled" out of view by the contents of
a new screen. In the past, the scroll back buffer provided an exact duplicate of lines that were displayed on the screen.
This was in the era where the host wrote physical lines to the screen (a physical line was one that contained line
termination characters such as an line feed and or a carriage return). Most current applications use the concept of full
screen mode in which data is placed upon the screen based upon the current cursor location. Data written to the screen
in this manner cannot be placed within the scroll back buffer.

The special terminal menu item "Reset Cursor” will restore (display) the terminal cursor if it is hidden for some reason.
The host application has the ability to hide the cursor, and sometimes forgets to turn it back on. Under most conditions,
this menu item will not have to be used.

The special terminal menu item "Reset Terminal” is much like the previous item, in that it can be used when a host
application is aborted and leaves the terminal in an unknown state.

The Send Short and Long Break menu items are used to send a break signal. If the current connection is over a modem,
a modem break hardware signal will be sent. If the current connect is over a telnet channel, a telnet break command will
be sent.

The "Telnet Abort" menu items sends a telnet abort command, which will stop the current running host application.
This command is only useful for telnet connections.
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View Menu

The view menu allows the Toolbar, animation, StatusBar, Terminal Status line and QuickConnect items to be toggled
on/off. The Office XP Look menu items controls the look of items such as the Toolbar.

The Binary mode item toggles the active SecureNetTerm session between normal 7-bit ASCII mode and 8-bit binary
mode.

The Session Logging item toggles session logging on/off. See session logging for additional details.

Tools Menu

The tools menu provides the ability to define commonly used programs, which can be started from within
SecureNetTerm. In addition, the customize menu item provides access to a User Management panel, which allows for
user customization of SecureNetTerm. The User Management panel contains four tabs; Commands, Keyboard, Tools,
and Options.

The tools tab allows you to define commonly used programs, which you can start from within SecureNetTerm. Simply
select the customize menu, select the tools tab, then press the New (Insert) icon. Then add a description name for the
program you wish to add to the menu, and then define the directory/path to that program. The descriptive name you
selected for the program will appear as an entry within the tools menu.

The Keyboard tab provides an easy way for you to associate an accelerator key to a menu or toolbar item.

Options Menu

The Options menu, consisting of five groups, is designed to provide easy access to SecureNetTerm utilities and program
support.

The first group, certificate support, provides limited X509 certificate support for those that use the SSL/TLS interactive
host servers. The first item, Certificates..., will display all the certificates owned by the current computer user which are
contained within the Microsoft Certificate Store. Those companies that allow user created access certificates to be used
as valid certificates for host authentication may use the second menu item, Create User Certificate. The third menu item,
Show Server Certificate... will display the certificate presented by the host computer at login time.

The second group, SSH utilities, are active whenever a connection is made to a SSH style server.

The next three groups are used to start commonly used programs and to customize portions of SecureNetTerm.

Script Menu

The script menu controls running scripts on demand. The Run menu item will bring up a file open dialog to select the
desired script. Once the script is opened, it will be passed to the script engine for processing. The Stop menu item will
stop the current running script.

The bottom half of the menu contains a "MRU" (most recently used) selection list of the last ten scripts run. These
scripts can be run by selecting the desired script from the list.

The MRU list can be cleared by pressing the shift key concurrently with the Run menu item.

Language Menu

The language menu allows for the selection of the GUI desired language.



Window Menu

The window menu keeps track of multiple instances of SecureNetTerm, and allows you to switch to another instance.
The “Save Window Position” menu item will save the current screen location of the window. Subsequent launching of
this host profile will place the window in the saved position. The saved positon can be cleared in the Advanced Host
Settings-Extended Options dialog.

The "Tile Windows" menu item will place all windows on top of each other, starting with the x,y location of the first
active SecureNetTerm window. This is useful for multiple SecureNetTerm windows being placed in the same location
on the screen, and using the Window Tab Bar to toggle between the windows.

The "Cascade Windows" menu item will cascade all SecureNetTerm windows starting with the active windows upper
left top position. The active window will remain the top most window of the cascade.

Help Menu

The help menu contains support for displaying this help file, displaying/enabling the tip file, registering the program and
www browser access to SecureNetTerm's home page. The about menu item displays the current program version
information.

ToolBar

The toolbar, located at the top of the main window, provides one-click access to commonly used functions. The toolbar
contains seventeen icons, divided into five major groups.

Connect Connect to the active host.

Host History Maintains a MRU of connected hosts. (See below)
Disconnect Close the current connection.

Site Profile Manager Start the Site Profile Manager

Advanced Host Settings Bring up the Advanced Host Setting dialog

Global Settings Start the Global Settings Dialog

Keyboard Keys Start the Keyboard Key definition dialog

Font Change the active host font

Print Screen If connected, print the current screen

Save Screen If connected, save the current screen to a file

Copy If connected, save the current screen to the clipboard
Paste If connected, paste the clipboard to screen

Script Editor Start the internal script editor

Run Script Run the current script

Stop Script Stop the current script

Start SecureFTP Run the SecureFTP program. (See below)

Abort Transfer/Connect Abort Request (See below)

The Host History dropdown maintains a MRU (Most Recently Used) list of hosts, which have been connected to. You
can connect to the hosts within this list by simply selecting a host from the list. 1f SecureNetTerm is already connected
to a host, a new instance of SecureNetTerm will be used to connect to the selected host. Pressing the Host History
button, when connected, will start a new instance of SecureNetTerm to the currently connected host. It the shift key is
pressed when the Connect Dropdown is selected, the MRU list will be cleared.

The Script Editor, Run Script and Stop Script items allows for the loading, editing and running of a script on a one time
basis. Once a script has been selected, it will be "remembered”, by host.
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The Start SecureFTP item will start the SecureFTP program. The installation location of SecureFTP must be defined in
the Global Settings-Applications dialog. If SecureNetTerm is not connected to a host, SecureFTP will be started
normally, that is, without command line input. If SecureNetTerm is connected to a host, SecureFTP will be started and
passed the active profile. SecureFTP will then begin a connection to the host specified by that profile. For example, if
SecureNetTerm is connected to a SSH based host with an active profile name of \mySFTP\SSH-2, then SecureFTP will
be started with a command line input of —profile \mySFTP\SSH-2, which will instruct SecureFTP to connect to the SSH
host specified by the profile. See the section on Dual Use hosts in the Site Profile Manager.

The Abort Transfer/Connect icon has several different functions, depending upon the state of SecureNetTerm. If a
connection is being attempted, pressing this icon will abort the connection attempt and all connection retries. If a file
transfer is in progress, it will attempt to abort the transfer. If SecureNetTerm is displaying a large amount of data being
sent from the host, you can use the Abort icon to stop the flow of the data, and request the host to stop the application
that is generating the output. When used for this purpose, wait a few seconds after you press the Abort button. This will
allow time for the host and network to clear its buffers. Then press the Abort button again to resume normal operations.

The ToolBar can be turned off in the View menu.

StatusBar

The status bar is composed of nine informational areas consisting of:

General Messages

File Transfer progress meter

Emulation Type

Security indicator

Current time or Row/Column

LED display

Printer Active/Keyboard locked indicators
Caps Lock indicator

Num Lock indicator
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The StatusBar can be turned off in the View menu.

Right Mouse Menu

The right mouse menu contains unique and selected options within SecureNetTerm that are commonly used, and places
them in one easy to access location. The menu consists of:

Copy Copy highlighted text to the clipboard.
Paste Paste contents of clipboard to current screen.
Copy/Paste Perform copy/paste in one operation.

Launch Highlighted URL Proccess the highlighted URL

Copy Screen Copy current screen to clipboard.

Edit Screen Edit the current screen with the user defined editor.
Save Screen Save current screen to a file.

Clear Screen Clear the current screen.

Print Screen Print the current screen.




Copy Scroll Buffer Copy the scroll buffer to the clipboard.

Edit Scroll Buffer Edit the scroll buffer with the user-defined editor.
Save Scroll Buffer Save the scroll buffer to a file.

Clear Scroll Buffer Clear the current screen and the scroll buffer.

Print Scroll Buffer Print the scroll buffer.

Edit Highlighted Text Edit the highlighted text with the user-defined editor.
Print Highlighted Text Print the highlighted text.

Command Line

When started, SecureNetTerm will check for command line arguments. Valid arguments are an optional profile name, an
alternate .xml file (the Site Profile File) and/or a valid URL to use. If specified, the profile name must be specified with:

-profile

and it must specify a unique profile name to use for an immediate connection.. If an alternate Site Profile File is desired,
it must be preceded with:

—i
The following are valid combinations:
-profile \Telnet\MyHost
-profile "\Telnet\Telnet Test"
-i \c:\temp\SecureCommon.xml
If the profile or Site Profile File name contains spaces, the name must be enclosed within quotes.
Note that the profile name can be obtained from the Site Profile Manager, "Profile Name" text box.

SecureNetTerm can also be passed a telnet style URL on the command line. If this option is selected, it must be the only
item on the command line. A telnet URL follows the common Internet scheme syntax, defined as:

URL-type://<userid>:<password>@<host>:<port>/<url-path>?<typecode>

The URL-type must be telnet.
If the optional port is omitted, the port defaults to 23. If a port of 22 is specified, the protocol will be set to SSH-2.

If either the optional userid/password is omitted, and it is required by the host during the connection phase, it will be
requested by SecureNetTerm.

The optional ?<typecode> specifies the data transfer format, and <typecode> can be one of the characters "i" or "a",
representing binary or ASCII data respectively. These are not supported at the current time.

An example telnet URL would be:

telnet://zkrrO1:mypass@secure.netterm.com:22
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telnet://zkrr01:mypass@secure.netterm.com:22/

The optional <url-path> can be used to specify a default host profile to use for the connection. The character '/ is not a
part of the <url-path>, it is a required deliminer if the <url-path> is specified. If the optional <url-path> is specified, the
optional userid, password, host and port will override the values in the profile specified by the <url-path>. An example
URL containing a default profile would be:

telnet://zkrr01:mypass@secure.netterm.com:22/\mySFTP\OpenSSH-Password

Host Mouse Support

SecureNetTerm supports two models for host mouse support. The first is the standard XTERM model and is active only
when the XTERM emulation is selected. The second is the Locator Input Model for ANSI Terminals, which is for all
other emulations. In both models, the host must activate the mouse support. If the host has not activated mouse support,
then normal Windows style mouse support will be in effect. Note that pressing the right mouse button will activate the
right mouse popup menu containing many of the same items contained within the SecureNetTerm menu. The UNIX
based program "Midnight Commander" (mc) is a good example of a host application, which supports XTERM style
mouse support.

Host Editing

The host-editing feature allows text-based files to be downloaded from the host, and passed to a user-defined editor for
modification or viewing. This feature requires a special program (named netedit.c) to be uploaded to your host and then
compiled and linked. Simply transfer the file netedit.c (located in the SecureNetTerm directory) to your host then issue
the following commands:

cc netedit.c -o netedit
chmod +x netedit

On some systems, you can also replace the first line with make netedit, then do the chmod +x netedit command.

To edit a host file, simply enter 'netedit xxxxxx' where xxxxxx is the file name to be edited. The file will then be
transferred to your system, and the user-defined editor will be started with the file name received as a command line
input. The Windows program 'Notepad' is sufficient for most cases. If you make any changes to the file, be sure to save
it. SecureNetTerm can then detect that changes were made, and will then upload the file back to the host system. If no
changes are made, SecureNetTerm will inform the host base netedit program of that fact. If changes are made, the host-
based netedit program will create a new file, and if successful, it will replace the current file with the new file.

The host-editing feature described above uses the same logic as transparent printing to transfer files to the local machine
and uses the same basic logic as ASCII file transfers to return the file back to the host. Although effective on most
UNIX machines, some text files contain data that will prevent successful uploads back to the host. Text files containing
'long lines' such as those produced by word processors or some HTML editors cause this.

A second, more powerful way for editing host files is with the SmartEdit feature. This method uses the standard
Zmodem file transfer to move files between the host and SecureNetTerm for editing, thus allowing binary files such as
bitmaps and other graphic files to be edited with a graphical editor. Since the standard Zmodem file transfer routines are
used, all the normal file transfer options apply. This allows a file to be transferred, retaining its file name on the local
machine. The SmartEdit feature requires that the file ‘se” be transferred to the host. Once it is on the host, just enter
chmod +x se to enable it for operation.

SmartEdit uses the normal Windows extension support to determine which program to use to edit the file As with the
first editing method, SecureNetTerm will examine the file length, date, and time to determine if the file was changed
when the editing program exits.


telnet://zkrr01:mypass@secure.netterm.com:22/

WWW Browser Support

SecureNetTerm is designed to be the preferred telnet client of choice for www browsers. Select any telnet URL within a
browser and SecureNetTerm will connect to that site. In addition, if you come across any type of URL while in a Telnet
session, simply highlight the URL, then use the right mouse click, launch this URL option and SecureNetTerm will call
your browser to connect to that URL

In order to define SecureNetTerm as the Telnet client for www browsers, use the SecureNetTerm Global Options-
Applications-WWW Browser Telnet Handler option.

Supported Emulations

SecureNetTerm supports the following terminal emulations:

ANSI
ANSI-BBS
ANSI-CIS
BA-80
FTTERM
IBM-3101
IBM-3151
IBM-3161
IBM-3163
QNX2
SCO-ANSI
TVI1925
VT52
VT100
VT102
VT220
VT320
WYSES0
WYSEGO
XTERM
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Keyboard Support

Overview

Keyboard definition for problematic keys is supported through a standard dialog panel. Selected keys, displayed within
the dialog panel, can be programmed to transmit strings of your choosing. Each key can be set up to transmit one string
when pressed by itself, a second string when pressed together with the <Shift> key, a third string when a key is pressed
together with the <Ctrl> key, a fourth string when the Num Lock key is on, a fifth string when a key is pressed together
with both <Ctrl> and <Shift>, and a sixth string when a key is pressed together with the <alt> key. The key definitions
are stored concatenated together into a single string, whose total length cannot exceed 60 characters. The sub-strings are
separated by the pipe character ('|', ASCII 0174). Keys should not be defined when you are connected to a host.

Special sequences such as escape, carriage return, and line feed are specified with the ' symbol along with the printable
‘equivalent’ of the character. For example <Ctrl-c> would be encoded as *C. To send the "' symbol, you must escape it
with the \' character. The following are some additional samples:

N Escape
M Carriage Return
~J Line Feed

Special sequences can appear at any point within the user-defined string for the specified key. For UNIX systems, the
definition must match that within the corresponding TERMCAP or TERMINFO file. For dial-up lines, the keys can be
defined to send any string. For example, you could define F1 to send the string 'ftp ftp.cica.indiana.edu"M', and F2
could be defined to send your Email address.

The Windows Common User Access: Advanced Interface Design Guide gives special meaning to the F1 key and the
ALT key sequence. This presents programs such as SecureNetTerm with some design problems, since it must pass keys
to another host, which in turn will process the keys according to their rules.

The F1 key is defined by the CUA guide as a user help key. SecureNetTerm will treat F1 as a user help key if it is not
connected to any host; otherwise it will be passed on the host system as any other key. The ALT key sequence will
normally be treated according to the CUA guide, that is these key codes will not be sent to the host. There are two
exceptions to this. The first exception is for the twelve keys F1-F12. If these keys are defined with the ALT key
modifier, then the defined data with is sent to the host. If the key is not defined, normal window actions will be
honored. For example, ALT-F4 is normally used to terminate a program. If you define ALT-F4 using the keyboard
dialog panel, then that definition will be sent to the host, and the normal Windows action will not take place.

If the first character of a key definition contains the "~" or "@" character, then the key is considered a local workstation
key. A local workstation key can be used to select menues, or to run programs and scripts. The menu feature is enabled
by prefixing a menu items label with the '~' character. For example, to select the Options-Certificates... menu item, use:

~Certificates...

The run feature is enabled by prefixing the full path of the program with the ‘@’ character. This feature supports
running programs or scripts. For example, to start the Windows Notepad program, the entry would be:

@Notepad.exe

Keyboard Definition

To setup custom values for keys, press the keyboard icon to bring up the keyboard dialog panel. Check to see if the
keyboard definition you desire to change is loaded (lower left corner of the panel). If it is not, select the desired
definition from the list of available definitions. To define a key, simply click the key with the mouse button and enter



the new definition within the edit box at the bottom of the panel. After you have entered the new definition, press the
"Change" push-button to make the change. If you want to define a Shift or Ctrl key sequence, click either Shift or Ctrl
first, then click on the desired key. The Shift or Ctrl will stay on (as indicated by the buttons on the upper right of the
panel) until you click on this again. The left Ctrl, Alt, Shift, and Caps Lock keys cannot be programmed. Normally, the
only keys you should program are the twelve function keys. The most common reason to program any key is to reduce a
long sequence of characters to a simple keystroke.

If you want to change the name of the keyboard definition, simply type over the current name. Once you have made all
your changes, save the values by depressing the "OK" button. The new key definition will remain active until (1) you
exit the program, or (2) you select a new host profile from the Profile Manager. If you wish to use the new key
definition for a host profile, you must select that key definition in the Profile Manager. The purpose for keeping the new
key definition active is to allow key changes while currently connected to a host, and then testing those changes while
connected.

Accelerators

Since SecureNetTerm is designed to provide keyboard input for another host, the use of accelerators has been minimized
to avoid conflicts with key definitions required by the host. The two exceptions to this are for the clipboard copy and
paste functions. The accelerators Ctrl+Ins and Shift+Ins have been chosen for these. In addition, an option has been
added to the Global Settings-Control dialog to turn on/off the use of accelerators. The default is off, which means the
accelerators are not active. To allow the use of accelerators, simply select the 'Allow Edit Accelerators' option. A
check mark will indicate that the option is turned on.

Numeric Keypad

The numeric keypad presents some additional requirements upon SecureNetTerm. The definition of the keys depends
upon the state of the Num Lock key, and the type of emulation.

Note that the host under most conditions controls the numeric keypad.
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Global Settings

Terminal

Options

The option "Bell on," allows for ignoring bell characters received from the host. The "Ignore Numeric Keypad" option
allows SecureNetTerm to ignore host's requests to change the state of the keypad. This option is useful for portables,
which do not have a normal numeric keypad.

The "Allow Program Calls" controls whether special host escape sequences can start a program on the users workstation.
SecureNetTerm allows host applications to start programs on the workstation if this option is selected.

The "Allow Edit Accelerators™ allow shortcut keys to be used for copy/paste options. Since SecureNetTerm is a
terminal emulator, normally all the keys are defined by the emulation selected. However an exception can be made for
the copy/paste operation.

The "DEC LK-450 Keyboard" option can be selected whenever a real DEC LK-450 keyboard is used on the
workstation. This keyboard is designed after the real DEC VT series of terminals and contain special keys used by many
DEC based hosts.

The "Right mouse click is copy/paste" option redefines the right mouse click default action. Normally, the right mouse
click will bring up the right mouse menu. If this option is selected, the right mouse click will perform a copy/paste if
text is highlighted on the terminal screen. If text is not highlighted on the terminal screen, the logic will then check to
see if text is on the clipboard, and if so, will do a normal paste. When the copy/paste option is selected, a shift-right
mouse click will bring up the right mouse menu. See the Mouse Selection topic for additional details.

The "Left mouse click sends row/column” option redefines the left mouse click default action. Normally the left mouse
click will start a highlight text operation. If this option is selected, a left mouse click will send the current row/column
location at the location of the left mouse click. This option should only be used with host applications designed to
support this option, and it should be noted that this is not a standard feature of any known emulation. The selection of
this option will also disable the double left mouse click hightlight word feature.

The "Ignore window title change requests" will prevent the host from changing the main window title, as well as the
description on the window switching tab. Several host emulations, such as XTERM, have the ability to change the
window title, often without the users specific knowledge.

The WAV File allows the selection of a Windows WAV file to be played whenever a file transfer completes.
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The global download directory define where files transferred downloaded from the host will be placed. The global
upload directory defines the default directory for files to be uploaded. Downloaded files will always be placed in the
download directory. Uploaded files can be selected from any directory, but will default to the global upload directory.

Printing

SecureNetTerm has the ability to recognize the standard emulation escape sequences for printing. For VT-XXX
emulation, whenever the escape sequence CSI[5i is received, a temporary file will be created and opened. Any data
received after this point will be written to the file. When the escape sequence CSI[4i is received, the file will be closed.
The following is an example of a UNIX script which will send the contents of a UNIX file to a local file for printing:

#!/bin/sh

echo \033[[5i'
cat $1

echo \033[[4i'

Data received after the transparent print option has been turned on will be captured in a temporary disk file. Once the
printer data has been received and transparent printing is turned off, the file will be printed on your default Windows
printer or processed according to the print option selected. Print options, such as the default font and font size for the
printed file can be selected from Options-Global Settings-Printing menu item or from the toolbar. The temporary file
which was created will be deleted by SecureNetTerm, if the 'delete file option is selected'. The following options control
the handling of the printer data:

Receive File Only - Place the print data into a file.

Send to Windows printer - Send to the default Windows printer driver for processing.

Start user defined print program - Start the user defined print program, passing the file name.

Start user editor program and edit the file - Start the user defined edit program, passing the file name.
Add the print file directly to the Windows spooler queue - Add file directly to spooler queue.

6. SmartPrint - Queue all printout - Print on user demand.

agrwpE

Option four is designed to handle print files, which contain special printer control characters. This option should be
used when printer formatting is done on the host. An example of this is a host-based application that creates a form,
which includes laser jet print commands to set the font size, orientation, etc. Note that the File option 'Print Screen' is
also controlled by the six print options, although option two is normally used.

The SmartPrint option allows for the receipt of multiple print documents throughout the session to be placed within a
common print file. The file can be printed, saved to another file, edited or deleted at any time.

The 'Display Print Setup at print time' option will display the standard Microsoft Print Setup dialog prior to printing,
which allows for printer selection, paper orientation and other desired printer setup.

The file 'netprint’, located within the SecureNetTerm directory, can be uploaded to your host using the rz command.
Then issue the command chmod +x netprint. To print a file, simply enter netprint xxxxxx on the host, where Xxxxxx is
the file name to be printed. In essence, the netprint script can download any ASCII file to your machine. It passes all
data received from the UNIX host to the local file, except for the binary zero character.

For all emulations other than VT-XXX, refer to the respective programmers manual for specific transparent printing
escape command definitions.

Advanced

The advanced dialog allows for additional control over how transparent printing is handled, additional control of how
the host bell character is handled and a couple of general items that some installations need.

When the current screen, or scroll buffer is printed, a decision must be made on how to handle special graphical
characters. SecureNetTerm itself has the ability to display multiple fonts concurrently, which allows normal text and
graphical characters to be displayed on the same screen. However, most printers do not have this ability. In order to



display the text characters, and the line drawing characters, a printer font (such as the Microsoft Line Draw font) must be
used. If this font, or similar font is not available or supported by the printer then SecureNetTerm can translate the line
drawing characters to normal text characters.

Ansi Colors

Graphic attributes are the set of colors, which can be specified by the ANSI graphics attribute for
background/foreground colors. This set contains sixteen colors, composed of the basic eight colors; black, blue, green,
cyan, red, magenta, brown and white. Each base color is associated with the ANSI graphics color attribute zero through
seven. Each of the base colors also has a corresponding high-intensity value that is used when